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When	is	the	best	to	provide	a	portrait	and	landscape	layout	for	your	android	application.	Android	studio	landscape	and	portrait	layout.	Different	layout	for	portrait	and	landscape	android.	Android	portrait	and	landscape	screen	layout	example.	Create	layout	portrait	and	landscape	android.	How	to	change	landscape	to	portrait	on	android.	Android
layout	xml	landscape	portrait.	Android	portrait	and	landscape	layouts.

I've	seen	references	to	being	able	to	specify	two	separate	layout	xml	files	for	an	activity,	one	for	Portrait	and	one	for	Landscape.	I've	not	been	to	find	any	information	on	how	to	do	that	though.	How	do	I	specify	for	each	activity	which	xml	file	is	it's	portrait	layout	and	which	is	the	Landscape	layout?	Is	it	also	possible	to	specify	different	layouts	for
different	screen	sizes?	If	so,	how	is	this	done?	You	may	recall	that	when	the	user	changes	the	orientation	of	the	device,	the	Android	framework	destroys	and	recreates	the	current	activity.	The	new	orientation	often	has	different	layout	requirements	than	the	original	one.	For	example,	the	MaterialMe	app	looks	good	in	portrait	mode,	but	does	not	make
optimal	use	of	the	screen	in	landscape	mode.	With	the	larger	width	in	landscape	mode,	the	image	in	each	list	item	overwhelms	the	text	providing	a	poor	user	experience.In	this	task,	you	create	an	alternative	resource	file	that	will	change	the	appearance	of	the	app	when	it	is	used	in	landscape	orientation.1.1	Change	to	a	GridLayoutManagerLayouts
that	contain	list	items	often	look	unbalanced	in	landscape	mode	when	the	list	items	include	full-width	images.	One	good	solution	is	to	use	a	grid	instead	of	a	linear	list	when	displaying	CardView	elements	in	landscape	mode.Recall	that	the	items	in	a	RecyclerView	list	are	placed	using	a	LayoutManager;	until	now,	you	have	been	using	the
LinearLayoutManager	which	lays	out	each	item	in	a	vertical	or	horizontal	scrolling	list.	GridLayoutManager	is	another	layout	manager	that	displays	items	in	a	grid,	rather	than	a	list.When	you	create	a	GridLayoutManager,	you	supply	two	parameters:	the	app	context,	and	an	integer	representing	the	number	of	columns.	You	can	change	the	number	of
columns	programmatically,	which	gives	you	flexibility	in	designing	adaptive	layouts.	In	this	case,	the	number	of	columns	integer	should	be	1	in	portrait	orientation	(single	column)	and	2	when	in	landscape	mode.	Notice	that	when	the	number	of	columns	is	1,	a	GridLayoutManager	behaves	similar	to	a	LinearLayoutManager.This	practical	builds	on	the



MaterialMe	app	from	the	previous	practical.Continue	developing	your	version	of	the	MaterialMe	app,	or	download	MaterialMe.	If	you	decide	to	make	a	copy	of	the	MaterialMe	project	to	preserve	the	version	from	the	previous	practical,	rename	the	copied	version	MaterialMe-Resource.2.	Create	a	new	resources	file	called	integers.xml.	To	do	this,	open
the	res	folder	in	the	Project	>	Android	pane,	right-click	(or	Control-click)	on	the	values	folder,	and	select	New	>	Values	resource	file.3.	Name	the	file	integers.xml	and	click	OK.4.	Create	an	integer	constant	between	the	tags	called	grid_column_count	and	set	it	equal	to	1:5.	Create	another	values	resource	file,	again	called	integers.xml;	however,	the
name	will	be	modified	as	you	add	resource	qualifiers	from	the	Available	qualifiers	pane.	The	resource	qualifiers	are	used	to	label	resource	configurations	for	various	situations.6.	Select	Orientation	in	the	Available	qualifiers	pane,	and	press	the	>>	symbol	in	the	middle	of	the	dialog	to	assign	this	qualifier.7.	Change	the	Screen	orientation	menu	to
Landscape,	and	notice	how	the	directory	name	values-land	appears.	This	is	the	essence	of	resource	qualifiers:	the	directory	name	tells	Android	when	to	use	that	specific	layout	file.	In	this	case,	that	is	when	the	phone	is	rotated	to	landscape	mode.8.	Click	OK	to	generate	the	new	layout	file.9.	Copy	the	integer	constant	you	created	into	this	new
resource	file,	but	change	the	value	to	2.You	should	now	have	two	individual	integers.xml	files	grouped	into	an	integers.xml	folder	in	the	Project	>	Android	pane.	The	second	file	is	labeled	with	the	qualifier	you	selected,	which	is	land	in	this	case.	The	qualifier	appears	in	parentheses:	integers.xml	(land).1.2	Modify	MainActivityOpen	MainActivity,	and
add	code	to	onCreate()	to	get	the	integer	from	the	integers.xml	resource	file:The	Android	runtime	will	take	care	of	deciding	which	integers.xml	file	to	use,	depending	on	the	state	of	the	device.2.	Change	the	LinearLayoutManager	for	the	RecyclerView	to	a	GridLayoutManager,	passing	in	the	context	and	the	newly	created	integer:3.	Run	the	app	and
rotate	the	device.	The	number	of	columns	changes	automatically	with	the	orientation	of	the	device.When	using	the	app	in	landscape	mode,	you	will	notice	that	the	swipe	to	dismiss	functionality	is	no	longer	intuitive,	since	the	items	are	now	in	a	grid	rather	than	a	single	column.	In	the	next	steps,	you	turn	off	the	swipe	action	if	there	is	more	than	one
column.Use	the	gridColumnCount	variable	to	disable	the	swipe	action	(set	swipeDirs	to	zero)	when	there	is	more	than	one	column:2.	Use	swipeDirs	in	place	of	the	swipe	direction	arguments	(ItemTouchHelper.LEFT	|	ItemTouchHelper.RIGHT)	for	ItemTouchHelper.SimpleCallback():3.	Run	the	app	and	rotate	the	device.	In	landscape	(horizontal)
orientation,	the	user	can	no	longer	swipe	to	delete	a	card.The	Result	:Task	2	:	Support	tabletsAlthough	you	have	modified	the	app	to	look	better	in	landscape	mode,	running	it	on	a	tablet	with	physically	larger	dimensions	results	in	all	the	text	appearing	too	small.	Also	when	the	device	is	in	landscape	orientation,	the	screen	is	not	used	efficiently;	three
columns	would	be	more	appropriate	for	a	tablet-sized	screen	in	landscape	mode.In	this	task,	you	add	additional	resource	qualifiers	to	change	the	appearance	of	the	app	when	used	on	tablets.2.1	Adapt	the	layout	to	tabletsIn	this	step,	you	create	different	resource	qualifiers	to	maximize	screen	use	for	tablet-sized	devices,	increasing	the	column	count	to
2	for	portrait	(vertical)	orientation	and	3	for	landscape	(horizontal)	orientation.The	resource	qualifier	you	need	depends	on	your	specific	requirements.	When	creating	a	new	resource	file,	there	are	several	qualifiers	in	the	Available	qualifiers	pane	that	you	can	use	to	select	the	correct	conditions:Smallest	Screen	Width:	This	qualifier	is	used	most
frequently	to	select	for	tablets.	It	is	defined	by	the	smallest	width	of	the	device	(regardless	of	orientation),	which	removes	the	ambiguity	when	talking	about	“height”	and	“width”	since	some	devices	are	traditionally	held	in	landscape	mode,	and	others	in	portrait.	Anything	with	a	smallest	width	of	at	least	600dp	is	considered	a	tablet.Screen	Width:	The
screen	width	is	the	effective	width	of	the	device,	regardless	of	the	orientation.	The	width	changes	when	the	device	is	rotated,	since	the	effective	height	and	width	of	the	device	are	switched.Screen	Height:	Same	as	Screen	Width,	except	it	uses	the	effective	height	instead	of	the	effective	width.To	start	this	task:Create	an	integers.xml	resource	file
which	uses	the	Smallest	Screen	Width	qualifier	with	the	value	set	to	600.	Android	uses	this	file	whenever	the	app	runs	on	a	tablet.Copy	the	code	from	the	integers.xml	(land)	file	(it	has	a	grid	count	of	2)	and	paste	it	in	the	new	integers.xml	(sw600dp)	file.Create	another	integers.xml	file	that	includes	both	the	Smallest	Screen	Width	qualifier	set	to	600,
and	the	Orientation	qualifier	set	to	Landscape.	Android	uses	the	resulting	integers.xml	(sw600dp-land)	file	when	the	app	runs	on	a	tablet	in	landscape	mode.3.	Copy	the	code	from	the	integers.xml	(land)	file	and	paste	it	in	the	new	integers.xml	(sw600dp-land)	file.4.	Change	the	grid_column_count	variable	to	3	in	the	integers.xml	(sw600dp-land)	file.5.
Run	the	app	on	a	tablet	or	tablet	emulator,	and	rotate	it	to	landscape	mode.	The	app	should	show	three	columns	of	cards,	as	shown	in	the	first	figure	below.	Rotate	it	to	portrait	mode,	and	the	app	should	show	two	columns	of	cards,	as	shown	in	the	second	figure	below.	With	these	resource	qualifier	files,	the	app	uses	the	screen	real	estate	much	more
effectively.Tip:	If	your	app	uses	multiple	resource	files,	Android	will	use	the	resource	file	with	the	most	specific	resource	qualifier	first.	For	example,	if	a	value	is	defined	in	the	integers.xml	file	for	both	Smallest	Screen	Width	qualifier	and	with	the	Orientation	set	to	Landscape,	Android	will	use	the	value	for	Smallest	Screen	Width.	The	precedence	for
resource	qualifiers	and	resource	files	is	described	by	Table	2	in	the	App	resources	overview.2.2	Update	the	tablet	list	item	stylesAt	this	point,	your	app	changes	the	number	of	columns	in	a	GridLayoutManager	to	fit	the	orientation	of	the	device	and	maximize	the	use	of	the	screen.	However,	the	TextView	elements	that	appeared	correctly-sized	on	a
phone's	screen	now	appear	too	small	for	the	larger	screen	of	a	tablet.To	fix	this,	you	extract	the	TextAppearance	styles	from	the	layout	resource	files	into	the	styles.xml	resource	file.	You	will	also	use	resource	qualifiers	to	create	additional	styles.xml	files	for	tablets.Note:	You	could	also	create	alternative	layout	files	with	the	proper	resource	qualifiers,
and	change	the	styles	of	the	TextView	elements	in	those.	However,	this	would	require	more	code	duplication,	because	most	of	the	layout	information	is	the	same	no	matter	what	device	you	use,	so	you	will	only	extract	the	attributes	that	will	change.Follow	these	steps	to	add	the	TextAppearance	styles:Open	styles.xml	and	add	the	following	styles:2.
Create	a	new	values	resource	file	called	styles.xml	that	uses	the	Smallest	Screen	Width	qualifier	with	a	value	of	600	for	tablets.Copy	all	styles	from	the	original	styles.xml	file	into	the	new	styles.xml	(sw600dp)	file.In	styles.xml	(sw600dp),	change	the	parent	of	the	SportsTitle	style	to	"TextAppearance.AppCompat.Display1":3.	The	Android	predefined
Display1	style	uses	the	textColorSecondary	value	from	the	current	theme	(ThemeOverlay.AppCompat.Dark),	which	in	this	case	is	a	light	gray	color.	The	light	gray	color	does	not	show	up	well	on	the	banner	images	in	your	app.	To	correct	this	add	an	"android:textColor"	attribute	to	the	SportsTitle	style	and	set	it	to	"?android:textColorPrimary":The
question	mark	tells	Android	runtime	to	find	the	value	in	the	theme	applied	to	the	View.	In	this	example	the	theme	is	ThemeOverlay.AppCompat.Dark	in	which	the	textColorPrimary	attribute	is	white.4.	Change	the	parent	of	SportsDetailText	style	to	"TextAppearance.AppCompat.Headline".5.	To	update	the	style	of	the	TextView	elements,	open
list_item.xml,	and	change	the	style	attribute	of	the	title	TextView	to	@style/SportsTitle:6.	Change	the	style	attribute	of	the	newsTitle	and	subTitle	TextView	elements	to	@style/SportsDetailText.7.	Run	your	app	on	a	tablet	or	tablet	emulator.	Each	list	item	now	has	a	larger	text	size	on	the	tablet.2.3	Update	the	tablet	sports	detail	stylesYou	have	now
fixed	the	display	for	the	MainActivity,	which	lists	all	the	Sports	CardView	elements.	The	DetailActivity	still	has	the	same	font	sizes	on	tablets	and	phones.Add	the	following	style	in	the	styles.xml	file	for	the	detail	title:2.	Add	the	following	style	in	the	styles.xml	(sw600dp)	file	for	the	detail	title:3.	Open	activity_detail.xml,	and	change	the	style	attribute	of
both	the	newsTitleDetail	and	subTitleDetail	TextView	elements	to	the	new	SportsDetailText	style	you	created	in	a	previous	step:4.	In	activity_detail.xml,	change	the	style	attribute	of	the	titleDetail	TextView	element	to	the	new	SportsDetailTitle	style	you	created:5.	Run	your	app.	All	of	the	text	is	now	larger	on	the	tablet,	which	greatly	improves	the	user
experience	of	your	application.Task	3:	Localize	your	appA	“locale”	represents	a	specific	geographic,	political	or	cultural	region	of	the	world.	Resource	qualifiers	can	be	used	to	provide	alternate	resources	based	on	the	users’	locale.	Just	as	for	orientation	and	screen	width,	Android	provides	the	ability	to	include	separate	resource	files	for	different
locales.	In	this	step,	you	modify	your	strings.xml	file	to	be	a	little	more	international.3.1	Add	a	localized	strings.xml	fileYou	may	have	noticed	that	the	sports	information	contained	in	this	app	is	designed	for	users	from	the	U.S.	The	app	uses	the	term	“soccer”	to	represent	a	sport	known	as	“football”	everywhere	else	in	the	world.To	make	your	app	more
internationalized,	you	can	provide	a	locale-specific	strings.xml	file.	This	alternative-resource	file	will	show	the	word	"soccer"	to	users	in	the	U.S.	The	generic	strings.xml	file	will	show	the	word	"football"	to	users	in	all	other	locales.Create	a	new	values	resource	file.Call	the	file	strings.xml	and	select	Locale	from	the	list	of	available	qualifiers.	The
Language	and	Specific	Region	Only	panes	appear.3.	In	the	Language	pane,	select	en:	English.4.	In	the	Specific	Region	Only	pane,	select	US:	United	States	and	click	OK.	Android	Studio	creates	a	specific	values	directory	in	your	project	directories	for	the	U.S.	locale,	called	values-en-rUS.	In	the	Project	>	Android	pane,	the	strings.xml	file	in	this
directory	appears	as	strings.xml	(en-rUS)	within	the	newly	created	strings.xml	folder	(with	a	U.S.	flag	icon).5.	Copy	all	string	resources	of	the	generic	strings.xml	file	(now	located	in	the	strings.xml	folder)	to	strings.xml	(en-rUS).6.	In	the	generic	strings.xml	file,	change	the	Soccer	item	in	the	sports_titles	array	to	Football,	and	change	the	Soccer	news
text	in	the	sports_info	array	to	Football	news.3.2	Run	the	app	in	different	localesIn	order	to	see	the	locale-specific	differences,	you	can	start	your	device	or	emulator,	and	change	its	language	and	locale	to	U.S.	English	(if	not	already	set).	In	U.S.	English,	you	should	see	“Soccer”.	You	can	then	switch	to	any	language	and	locale	other	than	U.S.	English,
and	run	the	app	again.	You	should	then	see	“Football”.To	switch	the	preferred	language	in	your	device	or	emulator,	open	the	Settings	app.If	your	Android	device	is	in	another	language,	look	for	the	gear	icon:2.	Find	the	Languages	&	input	settings	in	the	Settings	app,	and	choose	Languages.	Languages	is	the	first	choice	on	the	Languages	&	input
screen.Remember	the	globe	icon	for	the	Languages	&	input	choice,	so	that	you	can	find	it	again	if	you	switch	to	a	language	you	do	not	understand:3.	For	devices	and	emulators	running	a	version	of	Android	previous	to	Android	7,	choose	Language	on	the	Languages	&	input	screen,	select	a	language	and	locale	such	as	Français	(France),	and	skip	the
following	steps.(In	versions	of	Android	previous	to	Android	7,	users	can	choose	only	one	language.	In	Android	7	and	newer	versions,	users	can	choose	multiple	languages	and	arrange	them	by	preference.	The	primary	language	is	numbered	1,	as	shown	in	the	following	figure,	followed	by	lower-preference	languages.)4.	For	devices	and	emulators
running	Android	7	or	newer,	choose	Languages	on	the	Languages	&	input	screen,	select	a	language	such	as	Français	(France),	and	use	the	move	icon	on	the	right	side	of	the	Language	preferences	screen	to	drag	Français	(France)	to	the	top	of	the	list.5.	Run	the	app	with	your	device	or	emulator.	In	U.S.	English,	you	should	see	“Soccer”.6.	Switch	to
any	language	and	locale	other	than	U.S.	English,	and	run	the	app	again.	You	should	then	see	“Football”.

21/11/2017	·	estoy	tratando	de	mostrar	una	vista	diferente	en	cada	orientación	de	pantalla,	para	lo	cual	tengo	un	fragment	y	dos	layouts,	un	archivo	xml	para	la	vista	Portrait	(vertical)	en	la	carpeta	layout;	y	otro	archivo	con	el	mismo	nombre	en	la	nueva	carpeta	layout-land.	30/11/2020	·	This	example	demonstrates	how	do	I	specify	different	layouts	for
portrait	and	landscape	orientations	in	android.	Step	1	−	Create	a	new	project	in	Android	Studio,	go	to	File	⇒	New	Project	and	fill	all	required	details	to	create	a	new	project.	Step	2	−	Add	the	following	code	to	res/layout/activity_main.xml.	Step	3	–	Create	a	layout	file	...	How	do	I	specify	different	layouts	for	portrait	and	landscape	orientations	in
Android?	Step	3	–	Create	a	layout	file	by	right-clicking	on	the	resources,	name	the	file,	from	the	‘Available	qualifiers,	select	Orientation.	Click	>>	option.	Select	Landscape	from	UI	mode.	4/1/2022	·	Steps.	1.	Swipe	down	from	the	top	of	the	screen.	This	displays	the	Quick	Settings	icons	at	the	top	as	well	as	your	notifications.	2.	Swipe	down	from	the
Quick	Settings	icons	again.	This	expands	the	Quick	Settings	menu	so	that	it	covers	the	entire	screen.	3.	Tap	the	Auto	Rotate	,	Portrait,	or	Landscape	icon.	androidx.health.connect.client.impl.converters.aggregate.	Overview;	Classes	Android	seleccionará	automáticamente	el	layout	portrait	o	landscape	si	los	hemos	creado	apropiadamente.	Como
sabemos	los	layouts	se	almacenan	en	XML	dentro	de	la	carpeta	layouts	del	proyecto.	Si	creamos	un	layout	con	el	mismo	nombre	pero	en	la	carpeta	layouts-land	entonces	android	seleccionará	el	layout	de	la	carpeta	-land.	Si	estamos	en	portrait	…	Fastest	way	for	Android	Studio	3.x.x.	1.Go	to	the	design	tab	of	the	activity	layout.	2.At	the	top	you	should
press	on	the	orientation	for	preview	button,	there	is	a	option	to	create	a	landscape	layout	(check	image),	a	new	folder	will	be	created	as	your	xml	…	20/9/2020	·	To	design	the	layout	for	the	landscape	mode	we	need	to	add	resource	directory	in	the	res	folder	of	the	project.	To	create	the	landscape	mode	right	click	on	the	res	folder	->	New	->	Android
Resource	Directory.	Now	one	pop	up	will	be	prompted.	Select	Orientation	Available	Qualifiers	and	then	“	>>	”	icon	at	right	side,	then	select	Landscape	...	Android	can	be	restricted	to	not	switch	the	screen	to	landscape	when	rotated.	Open	the	AndroidManifest.xml	file,	in	the	activity	declaration	element	add	the	attribute	screenOrientation	and	set	it	to
portrait.	.	The	screen	will	no	longer	rotate	when	the	device	is	turned.	22/10/2020	·	In	Android,	whenever	the	user	switches	to	landscape	mode	an	issue	is	encountered	in	which	some	of	the	widgets	become	invisible	(as	you	can	see	in	the	below	image)	and	so	in	this	scenario,	there	is	a	need	to	design	a	separate	layout	for	the	landscape	mode.	So	i	n
android,	every	application	is	designed	in	almost	both	the	orientations	i.e	Portrait	and	Landscape.
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